


Pour votre sécurité

A AVERTISSEMENT

instructions.

Lisez attentivement ce manuel afin d'utiliser cet appareil
correctement et d'éviter tout danger ou dommage matériel.

Vous risquez de vous blesser griévement si vous ne suivez pas ces

Utilisation de I'appareil

Ne pas démonter, réparer
ou modifier cet appareil
vous-méme.

Ne mouillez pas I'appareil
et ne le laissez pas tomber
dans I'eau.

Si I'appareil est mouillé, ne I'al-
lumez pas. Contactez un centre
de dépannage.

Ne posez pas |'appareil
dans un endroit humide,
poussiéreux ou couvert de
suie, ce qui pourrait
provoquer un incendie ou
une décharge électrique.

Ne laissez pas |'appareil
dans un lieu ou la tempéra-
ture excede 35 °C (95 °F) (ex
: sauna ou stationnement).
En été, la température a
l'intérieur d'une voiture peut
atteindre 80°C (176 °F).

Pour éviter les troubles auditifs

L'utilisation prolongée de I'écouteur ou du casque
peut fortement réduire votre acuité auditive.

Si vous vous exposez a un volume sonore supérieur a 85
dB pendant une durée prolongée, votre ouie sera
irémédiablement endommagée. Plus le son est élevé,
plus votre acuité auditive diminue (une conversation
ordinaire a un niveau sonore compris entre 50 et 60 dB
alors que celui provenant d'une route est d'environ 80 dB).
II'est fortement recommandé d'utiliser un volume sonore
moyen (le volume moyen est habituellement inférieur a
2/3 du volume maximal).

Si vous ressentez des bourdonnements dans les
oreilles, réduisez le volume ou n'utilisez plus
I'écouteur ou le casque.

Pour éviter tout risque d'acci laroute

Nutilisez pas I'écouteur lorsque vous conduisez une
bicyclette, une automobile ou une motocyclette.

Dans le cas contraire, vous risqueriez de provoguer un
accident grave. En outre, son utilisation est interdite par
la loi dans certaines régions. L'utilisation de I'écouteur sur
la rue, particuliérement sur les passages pour piétons,
pourrait entrainer des accidents graves.

Pour votre propre sécurité, assurez-vous que le cable de
I'écouteur n'entrave pas vos mouvements ou ne
s'accroche pas dans des objets environnants lorsque
vous faites de I'exercice ou lorsque vous vous promenez.



A ATTENTION Failure to follow all instructions lead to physical injuries or damage to the player.

Utilisation de I'appareil
Gestion des données importantes Evitez de causer des dysfonctionnements

Veillez a toujours —

enregistrer vos données les A Utilisez toujours les
plus importantes & j" accessoires fournis ou
ﬁ} approuvés par Samsung.

Notez bien que nous ne saurons
étre tenus responsables en cas de
perte des données due a une
panne, & une réparation ou a toute
autre cause.

Evitez de projeter de I'eau sur
I'appareil. Ne nettoyez jamais

Z ] ==l I'appareil & 'aide de produits
Evitez de causer des dysfonctionnements gf?;' o ch’i)rgiques (ex: benz‘éne ou
: @Qﬁ diluant) pour ne pas provoquer

d'incendie, de décharge

m F‘“tez tqlut |m.pa;13ttbrlétal Sl électrique ou une détérioration
- appareil (ex : chute de de la surface.

I'appareil). Ne posez pas
d'objets lourds sur

I'appareil.
P Ne posez jamais I'appareil
’;g‘ = brés d'objets émettant des
~a Empéchez les corps == ondes électromagnétiques
7 étrangers ou la poussiére @ goufr netpas provoguer de
ysfonctionnement.

de pénétrer dans
I'appareil.
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Information de base

Composants

| Vérification des accessoires

Lecteur Ecouteurs Cable USB CD d'installation

» L'aspect des accessoires est susceptible d'étre amélioré et modifié, sans notification préalable.



| Face avant, coté droit et dessus de I'appareil

Tous les touches sont de type ‘a effleurement’.

Interrupteur
Power
(Alimentation) et
Hold (Maintien)
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Affichage a I'écran

sjuesodwo)

Touche de retour
en arriére

» Haut parleur

Touche «~ = < »
Touche Lecture/Pause
et Sélectionner
Touche Menu




Information de base

Composants (suite)

| Face arriére/Arriere

\/ K/)—> Port USB
% Port de
> connexion

des écouteurs

v
Trou de
réinitialisation

[Face arriere] [Arriere]

Branchement des écouteurs [RRRmrrr P P PP PSP P PRI PPPPPIPPPPPRISS

» Face arriere

Ecouteurs



Information de base

Screen Display Information
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1 Affichage de la répétition de la lecture 6 Affichage de I'alarme &’
2  Egaliseur 7 Affichage de I'état de la batterie 5
3 Renseignements sur la musique 8 Affichage de la durée de lecture =}
4 Barre d'état de la lecture 9 Affichage de I'état Lecture/Pause g
) . =

5 Affichage du numéro de la plage en g

cours/du nombre total de pistes

”
= Les représentations a I'écran figurent a titre indicatif uniquement. L'écran réel de votre appareil peut
REVARQUE étre différent.




Information de base

Fonctions des touches

Fonctions et utilisation

Faites glisser la touche dans le sens opposé a la fleche et retenez-la pour
o (CHobr) ) allumer/éteindre I'appareil.
Faites glisser dans le sens de la fleche et relachez-la pour verrouiller les touches.

Appuyez longuement pour vous déplacer vers le menu principal.
Tapez rapidement pour vous déplacer vers I'écran précédent.

)

Déplacement vers le haut, vers le bas, sur la gauche, sur la droite et
sélection des fonctions.

Tapez pour vous déplacer d'une sélection vers le haut ou vers le bas.

Tapez pour vous déplacer d'une sélection sur la gauche ou sur la
droite.

Appuyez longuement pour vous déplacer continuellement vers le
haut ou vers le bas.

. Q Tapez rapidement pour sélectionner lecture/pause et la fonction, ou
pour vous déplacer vers I'écran suivant.

Recherche d'une piste et controle du volume en écoute de musique.
& Appuyez longuement sur la touche pour balayer vers un point sur
la piste en cours.

Tapez pour vous déplacer sur la piste précédente ou pour
lancer la lecture de la piste actuelle depuis le début.

Appuyez longuement sur la touche pour balayer vers un point sur
la piste en cours.

Tapez et relachez pour vous déplacer sur la piste suivante.
Tapez pour augmenter/diminuer le volume.

B = Tapez pour afficher le menu des options.
10



0Tapez sur I'écran tactile du bout
des doigts.

ATTENTION

= Nutilisez jamais d'objet pointu autre que le bout de vos doigts pour manipuler I'écran tactile.

Sinon, vous risquez de I'endommager.
= Ne tapez sur pas sur I'écran tactile avec des doigts sales.
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H Chargez la batterie completement avant d'utiliser
Ch arg em ent d e I a p I | e le lecteur pour la premiére fois ou lorsqu'il n'a pas

été utilisé depuis longtemps.

1 Branchez le cable USB sur le port
USB ( \I; ) de votre ordinateur.

2 Branchez I'autre extrémité du cable
USB sur le fiche USB situé dans la
partie inférieure du lecteur.
= Une fois que le lecteur est branché a l'aide du

cable USB, le temps nécessaire a un
chargement complet est d'environ quatre
heures; ce temps peut varier en fonction de
I'environnement installé sur ['ordinateur.

| utilisation de Ia pile

Rechargez et rangez I'appareil dans un lieu ou la
température est comprise entre 5 °C et 35°C (40
°F et 90 °F).

Evitez de surcharger la pile (plus de 12 heures).

Un chargement ou un déchargement excessif de
la pile peut réduire sa durée de vie.

Comme pour tout autre produit de consommation,
la durée de vie de la pile diminue progressivement
avec le temps.

= Sivous chargez le lecteur tandis qu'il est raccordé a votre bloc-notes, veillez & ce que la pile de ce
RENARQUE dernier soit complétement chargée.

12



Utilisation de base

| Mise sous et hors tension de I'appareil

Mise sous tension de I'appareil

Faites glisser I'interrupteur [ HOLD »] dans le sens opposé a la
fleche et retenez-le.

» L'appareil sallume.

Mise hors tension de I'appareil

Music seee Faites glisser de nouveau l'interrupteur [ HOLD »] dans le sens
opposé a la fleche et retenez-le.

= L'appareil séteint.

= L'appareil s'éteint automatiquement lorsque aucun des touches n'est actionné pendant une durée
REVARQUE prédéfinie (par défaut : 1 minute) en mode Pause (Pause). » Page 44

| Lire des fichiers musicaux

1 Appuyez longuement sur [ "] et retenez-la pour vous
déplacer vers le menu principal.

2 Tapez sur [ < *] pour sélectionner <Music> (Musique),
puis tapez sur [(O)].
1Lifeis cool = Le menu de musique s'affiche.
b 3 Utilisez [ =~ =] et [ )] pour sélectionner le fichier musical
souhaité.

4 Tapez sur [ O)].

= La lecture du fichier musical débute.

”
= Tapez sur [ D ] pour vous déplacer vers I'écran précédent.
REIARQUE = Appuyez longuement sur [ % ] pour vous déplacer vers l'écran du menu principal.
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Utilisation de base (suite)

| Réglage du volume

Tapez sur [ O)].

= Labarre d'état du volume s'affiche.

= Appuyez sur la touche [ ] pour augmenter le volume ou sur la touche [ ]
pour le diminuer.

1Lifeis cool

000210020

| Fonction Lock (Verrouillage)

En mode Hold, tous les touches sont désactivés. Vous apprécierez
particuliérement le c6té pratique de cette fonction lors de vos
marches ou de vos courses a pied.

1 Faites glisser I'interrupteur [ HOLD »] dans le sens de la
fleche et retenez-le.

1Lifeis cool

000210020

2 Faites glisser I'interrupteur [ HOLD »] dans le sens opposé a
la fleche pour désactiver la fonction de verrouillage.

14



| utilisation du haut parleur

Faites glisser le centre du lecteur dans les
sens de la fleche en cours d’écoute de
musique ou de la radio.

= Sivous souhaitez utiliser les écouteurs pour la
musique, désactivez le haut parleur en le faisant
glisser dans sa position originale.

» Veuillez placer le lecteur en position horizontale
lorsque vous utilisez le haut parleur.

= Sivous refermez le panneau coulissant, le haut
parleur est désactivé.

= Vous permet d'écouter la musique a l'aide du haut parleur.

Si un dysfonctionnement de I'appareil

survient, vous pouvez réinitialiser le

systeme en appuyant sur le trou de
Troude  ginitialisation.
réinitialisation

Appuyez sur la touche Reset situé sur la

partie inférieure de I'appareil a I'aide d'un

objet pointu, comme une un trombone.

= Le systéme est réinitialisé.

= Cela n'affecte pas vos réglages ou vos

fichiers.
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Chargement de vos fichiers préférés

Installation de Media Studio de Samsung e roier™

musicaux depuis votre
ordinateur vers le lecteur.

Insérez le CD d'installation fourni avec le lecteur dans le lecteur de CD-ROM

de votre ordinateur.

W)Hw‘

+ Install now

x Eit

InstaliShield Wizard X

T e e T D
following informatio

Cick CDSTOM o sl fer setup instlton setings o cick
INEXT] 1 stat copying s with the current stings.

Curent S ettings:

Installaton Type:
ik Instal: Select to nstall the Samsung Media Stud

e momaten
o Install:D:\Progiam Files\SamsunghSamsung
Jrcaltiine il i

recenle Tems of Use

cusTom Carcel

1 Cliquez sur <Install now>

(Installer maintenant).

2 Cliquez sur <NEXT> (SUIVANT).

= Linstallation de Media Studio est lancée.

= Une icone 2 est créée sur votre bureau a la
fin de l'installation et Media Studio est lancé.



Chargement de vos fichiers préférés

Branchement a votre PC

Utilisez le cable USB fourni pour brancher I'appareil sur I'ordinateur.

4

=

1 Branchez le cable USB au port USB ( ‘I/) de votre ordinateur.

2 Branchez l'autre extrémité du cable USB sur le fiche USB situé dans la partie
inférieure du lecteur.

| Configuration requise

Votre systeme d’ordinateur doit satisfaire les caractéristiques suivantes :

« Pentium 300 MHz ou plus » Windows XP Service Pack 2 ou ultérieur
= DirectX 9.0 ou version ultérieure = Port USB 2.0

= 100 Mo d'espace libre sur le disque dur = Lecteur de CD-Rom (2X ou plus)

= Windows Media Player 10,0 ou ultérieur « Résolution 1024 X 768 ou plus

= Sivous branchez le lecteur via un concentrateur USB, la connexion risque d'étre instable.

ATTENTION Veuillez brancher le lecteur directement a l'ordinateur.
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Chargement de vos fichiers préférés

Ajout de fichiers/dossiers dans Media Studio
de Samsung

Media Studio vous permet de sélectionner et de répartir vos fichiers et dossiers en
prévision du transfert vers votre lecteur.

SAMSUNG MedoSiudie (=ness

- 1- 1=

@ My PC Ao Porible
__M g ﬂi- skl n YPKSMTP]

baad T dhome fabm —— B8 e #rwtable (ypis X
| T mEn
. Cther mr A Fushcusa - Tha Bast - 10 When 1 Look. ..
e = [t ——"
I 2% 11 T Gt Be s Talfe 163
i s
o wie r
oy s |
G i i
s
Burn 0

| =L 1 28645 | 16 £3 NewFolder

L O]

{6%) selecrad Fies: 1, Torsl Fies: 10 @ Add Falder I < Addd File.

3 [= add Folder L\j}: AddFile |3——— =
1

Veuillez vous reporter a la section Aide pour obtenir plus d'informations sur
l'utilisation de Media Studio.

» Cliquez sur <MENU> (MENU) O <Help> (Aide) [ <Help> (Aide) dans le menu au haut du programme
Media Studio.



= Raccordez le lecteur a votre ordinateur.
= Media Studio doit étre installé sur 'ordinateur.

1 Media Studio démarre automatiquement lorsque vous branchez le lecteur sur
votre ordinateur.

= Sile programme ne démarre pas automatiquement, double-cliquez sur l'icone Media Studio située
sur le bureau.

2 Cliguez sur I'icone du fichier souhaité.
. Choisissez le type de fichier que vous souhaitez transférer en cliquant sur 'un de ces icones.
| &  représente un fichier musical et | @ représente une photo.

« Cliquez sur licone == pour afficher la liste ETC. La liste ETC comprend d'autres types de fichiers
(ex. : TXT, XOV, ETC) que les fichiers musicaux, photo et vidéo.

| Pour ajouter des dossiers

3 Cliquez sur <Add Folder> (Ajouter un dossier) au Rt ]
bas de I'’écran de Media Studio. ‘”“““‘"““*?””‘“’H .
» La fenétre Open Folder (Dossier ouvert) apparait.
Ty Docurerts
. i i i =13 My Computer
4 Sélectionnez les dossiers que vous souhaitez i Sraviad
ajouter et cliquez sur <OK> (OK). B A—

£ Al Users

» Le dossier sélectionné est ajouté sur la liste & gauche de
I'écran de Media Studio.

| Pour ajouter des fichiers

3 Cliquez sur <Add File> (Ajouter un fichier) au bas
de I'écran de Media Studio.

= La fenétre Open (Ouvert) apparait.

4 Sélectionnez les fichiers que vous souhaitez ajouter
et cliquez sur <Open> (Ouvrir).
= Les fichiers sélectionnés sont ajoutés sur la liste.
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Chargement de vos fichiers préférés

Transfert de fichiers vers le lecteur avec
Media Studio de Samsung

Effectuez les étapes suivantes pour transférer les fichiers depuis votre ordinateur
vers le lecteur.

o @@ 6D

B A Fortable
ﬂﬁ' [vPSTP]

T R e Thame | Ratr Py Court [ L e e e R (i

@ gy 133
af ] | -

0] e T Love 11 FarcmFr.. PECTARAe L . ey T Fashicsn - Ta B4t - 10. Whan 1Look
El Secane yaslovedme (] Celefon  Falrgiko'iou  Fop s Pache - Toe et - 35 Gont Trest L.,
Bl Ereatre Agan ToryBras.. fon iy 11 e’ Golta Eu e To Fe.ng
e Foradyater Moy LBge Mot crans  RES s —

2 o Tk W P, [ ey 06 e a5 E

] Shape of y Heart. strg Ten Summeners.. Rodk s e

@ Symaony o, (5. (1 Lidwigra.. el s real S

= When Youbeleve 1) Maih G, AUAGEIBAGA. .. i

Fenétre n
B ; Portable Eﬁa Srenttder

@ siectad s 3, Toes s 10 @ Add Folder | Add Fila

= La technologie de reconnaissance musicale et les données relatives sont fournies par Gracenote
webRQe et Gracenote CDDB® Music Recognition Service®.
= Le logo et le logotype de Gracenote, le logo et le logotype Gracenote CDDB et le logo “Powered

by Gracenote CDDB" sont des marques déposées de Gracenote. Music Recognition Service et
MRS sont des marques de service de Gracenote.




= Raccordez le lecteur a votre ordinateur.
= Media Studio doit étre installé sur 'ordinateur.

1 Media Studio démarre automatiquement lorsque vous branchez le lecteur sur
votre ordinateur.

= Sile programme ne démarre pas automatiquement, double-cliquez sur l'icéne Media Studio située
sur le bureau.
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2 Cliquez sur I'icone du fichier souhaité.
. Choisissez le type de fichier que vous souhaitez transférer en cliquant sur I'un de ces icones.
|4  représente un fichier musical et | @ représente une photo.

« Cliquez sur l'icone =S pour afficher la liste ETC. La liste ETC comprend d’autres types de fichiers
(ex. : TXT, XOV, ETC) que les fichiers musicaux, photo et vidéo.

3 Sélectionnez le fichier a transférer sur la liste de gauche.

4 Cliquez sur 'icbne & .
=« Le fichier sélection est transféré vers le lecteur.

funsues ap 01pniS eIPap
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= Ne débranchez pas le cable USB pendant le transfert du fichier sous peine d'endommager le lecteur
arevioy ou Tordinateur.

= Lors du transfert d'un fichier photo vers le lecteur a I'aide de <Media Studio> (Media Studio),
REMaRUE le fichier est converti automatiquement au format JPG avant le transfert. La taille du fichier est
également réglée automatiquement.

= Un fichier photo transféré vers le lecteur sans <Media Studio> (Media Studio) peut étre
différent de la source lors de son affichage sur I'écran du lecteur.
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Ecouter de la musique

Ecouter de la musique

A\l elendalie il Branchez les écouteurs, puis allumez le lecteur et vérifiez la batterie.

EXx. : lecture par artiste

Vs

N
1 Appuyez longuement sur [ 2 ] et retenez-la
pour vous déplacer vers le menu principal.
2 Tapez sur [ < *] pour sélectionner <Music>
(Musique), puis tapez sur [O)].
= Le menu de musique s'affiche.
3 Tapez sur [ % *] pour sélectionner <Artists>
(Artistes), puis tapez sur [)].

Menu Music (Musique)
<Now Playing> (En lecture) : permet de voir l'information de

la piece musicale actuelle.

<Artists> (Artistes) : pour effectuer une lecture par artiste
<Albums> (Albums) : pour effectuer une lecture par album
<Tracks> (Pistes) : pour effectuer une lecture par ordre
numérique ou alphabétique

<Genres> (Genres) : pour effectuer une lecture par genre
<Playlists> (Listes de lecture) : pour effectuer une lecture par
liste de lecture

REMARQUE

Les fichiers musicaux compatibles avec le lecteur sont aux formats MP3 et WMA.

Les fichiers MP1 ou MP2 possédant uniquement une extension modifiée vers MP3 peuvent ne pas étre lus.
Un fichier sans étiquette ID3 (informations musicales) s'affiche comme [unknown] (inconnu).

Les fichiers avec étiquette ID3 sont automatiquement répartis sur votre lecteur en fonction des
groupes Artists (Artistes) Albums (Albums) etc.

Une étiquette ID3 est la partie cachée de tout fichier musical et elle sert au classement.




Music

Muse @
» Now Playing

4 Tapez sur [ «~ =] pour sélectionner un artiste,
puis tapez sur [D)].
= Les albums de l'artiste apparaissent.

Tapez sur [ «~ =] pour sélectionner un album,

puis tapez sur [D].

= Les fichiers musicaux de I'album sélectionné
apparaissent.

Tapez sur [ «~ = ] pour sélectionner un fichier
musical, puis tapez sur [(O].
= La lecture de la musique démarre.
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E;outer de la musique

Ecouter de la musique (suite)

| Mode Pause (Pause)

1 Tapez sur [ (O] lorsque la lecture de la musique est en cours.
= La lecture de la musique est interrompue.

2 Tapez sur [ ()] une nouvelle fois.
= La lecture reprend a I'endroit ou vous I'avez suspendue.

= L'écran s'éteint automatiquement lorsque aucune des touches n'est actionnée pendant une durée
" prédéfinie (par défaut : 1 minute) en mode pause. Vous pouvez régler la période avant I'extinction de
FEMARQE pgcran, » Page 44

| Pour effectuer une recherche a l'intérieur d'une plage

1 Appuyez longuement sur la touche [ < * ] pendant que la plage sélectionnée est
en cours de lecture.

= Ces touches permettent d'effectuer la recherche vers le début ou la fin de la plage.

2 Relachez la touche dés que vous souhaitez reprendre la lecture.
= La lecture reprend au point ot vous avez relaché la touche.



| Lecture de la plage en cours & partir du début

Tapez sur [ < ] aprés 3 secondes de lecture.
= La plage en cours est lue a partir du début.

| Lecture de la plage précédente/suivante

Tapez sur [ < ] dans les 3 premiéres secondes de lecture.
» La lecture de la plage précédente démarre.

Tapez sur [ » 1.
= La lecture de la plage suivante démarre.

= Pendant la lecture de fichiers VBR, la plage précédente peut ne pas étre lue méme si vous appuyez
ATTENTION sur la touche [ < ] dans les 3 premiéres secondes de lecture.

=
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=
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=
=
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=
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=
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Ecouter de la musique

Créér une liste de lecture avec Media Studio de
Samsung

Une Liste de lecture est une liste de vos pieces musicales préférées.
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Cliquez sur la touche <My Album> (Mon album) au haut de Media Studio.
= La fenétre <My Album> (Mon album) apparait.

2 Cliquez sur la touche <New Album> (Nouvel album) au bas de I'écran.
= La fenétre Creation (Création) apparait.

3 Tapez le titre de I'album et cliquez sur <OK> (OK).

= Un nouvel album (liste de lecture) est créé et enregistré dans la section My Album (Mon album)
de Media Studio.



| Ajout de fichiers musicaux sur une Liste le lecture

Cliquez sur la touche <My PC> (Mon ordinateur)
au haut de Media Studio.
» La fenétre <My PC> (Mon ordinateur) apparait.

Cliquez sur la touche <To Album> (Vers I'album) a droite.
Cliquez sur la touche <My Album> (Mon
album) dans le coin droit de la fenétre.
= La fenétre Album (Album) apparait.

Cliquez deux fois sur I'album souhaité dans la
fenétre de droite.

Sélectionnez les fichiers que vous souhaitez
transférer dans la fenétre <My PC>
(Mon ordinateur).

Cliquez sur l'icone |y .

=
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» Les fichiers sélectionnés sont ajoutés a I'album (liste
de lecture).

| Exporter une liste de lecture vers votre lecteur & I'aide de Media Studio

Cliquez sur la touche <My Album> (Mon album)
au haut de Media Studio.
» La fenétre <My Album> (Mon album) apparait.

Cliquez sur la touche <Portable> (Portable)
dans le coin droit de la fenétre.

= La fenétre <Portable> (Portable) apparait.
Sélectionnez I'album souhaité sur la liste <My
Album> (Mon album).

Cliquez sur l'icone &y .

funswes ap o1pnis eIpap

03B 81N]J9| 8 31SI| duUN 1991D

= L'album sélectionné est transféré sur le lecteur et
enregistré dans <Music> (Musique) U <Playlists>
(Listes de lecture).



Ecouter de la musique

Pour lire une liste de lecture

LSy Reportez-vous aux pages 26 et 27 pour plus de détails sur la création et le
transfert de listes de lecture sur votre lecteur.

1 Appuyez longuement sur [ ®D ] et retenez-la pour vous
déplacer vers le menu principal.

2 Tapez sur [ % *] pour sélectionner <Music> (Musique),
puis tapez sur [D)].

= Le menu de musique s'affiche.

» Playlists

3 Tapez sur [ «~ = ] pour sélectionner <Playlists> (Listes de
lecture), puis tapez sur [(D].
= Le dossier Playlists apparait.

= Si une liste de lecture n’est pas trouvée, le message <No File> (Aucun
fichier) s'affiche a I'écran.

4 Tapez sur [ « = ] pour sélectionner le dossier de votre choix,
puis tapez sur [(D].

= Les fichiers musicaux enregistrés dans la liste de lecture sélectionnée
apparaissent.

5 Tapez sur [ «~ = ] pour sélectionner un fichier musical, puis
tapez sur [(D].

= La lecture du fichier musical démarre.



Ecouter de la musique

Utilisation du menu option de musique

| Pour sélectionner un effet sonore

Vous pouvez sélectionner des effets sonores variés ; ils vous permettent de
rehausser la musique que vous écoutez.

1 Tapez sur [ @] tout en écoutant la musique.
= Le menu des options de musique apparait.
o SoundEffect E 2 Tapez sur [ +~ = ] pour sélectionner <Sound Effect> (Effets
Sonores), puis tapez sur [O)].
= Le menu des effets sonores apparait.

3 Tapez sur [ = =] pour sélectionner I'effet sonore souhaité, puis
tapez sur [ ].

= Vous pouvez sélectionner entre <Normal> (Normal) <Vocal> (Voix)
<Bass Boost> (Ampli. basses) <3D Sound> (Son 3D) ou <Concert Hall>
(Salle concert).

| Pour sélectionner I'affichage de I'égaliseur graphique EQ

1 Tapez sur [ B ] tout en écoutant la musique.
= Le menu des options de musique apparait.

2 Tapez sur [ «~ =] pour sélectionner <Graphic EQ> (EQ
Graphique), puis tapez sur [(D].
= Le menu de I'égaliseur graphique apparait.

® Graphic EQ

/21N}23] P 811 BUN BlI| IN0d

3 Tapez sur [ «~ =] pour sélectionner <On> (Activé) ou <Off>
(Désactivé), puis tapez sur [ ].

= <On> (Activé) : I'égaliseur graphique s'affiche a I'écran.
= <Off> (Désactivé) : I'égaliseur graphique ne s'affiche pas a I'écran.

= L'égaliseur EQ ne peut étre ajusté.

REMARQUE

anbisnw ap uoido nuaw np uolesI|iN
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Ecouter de la musique

Utilisation du menu option de musique (suite)

| Pour sélectionner le Mode lecture

1 Tapez sur [ @] tout en écoutant la musique.
= Le menu des options de musique apparait.

2 Tapez sur [ «~ = ] pour sélectionner <Play Mode> (Mode lec-
ture), puis tapez sur [O)].
= Le menu du Mode lecture apparait.

» Play Mode

3 Tapez sur [ « =] pour sélectionner le mode souhaité, puis
tapez sur [OD)].
= Vous pouvez sélectionner <Normal> (Normal) <Repeat One> (Répéter
une fois) <Repeat> (Répéter) ou <Shuffle> (Aléatoire).

» <Normal> (Normal) : lecture ponctuelle et dans I'ordre de toutes les pistes.
» <Repeat One> (Répéter une fois) : répétition ponctuelle d'un fichier.

= <Repeat> (Répéter) : répétition de tous les fichiers (lecture en boucle).

= <Shuffle> (Aléatoire) : lecture aléatoire des fichiers.

| Pour ajouter des mélodies d’alarme

Vous pouvez ajouter votre fichier musical préféré a la liste des mélodies d’alarme
afin de pouvoir I'entendre la prochaine fois que I'alarme se déclenchera.
Reportez-vous a la page 40 pour le réglage de I'alarme.

1 Tapez sur [ @] tout en écoutant la musique.
= Le menu des options de musique apparait.

2 Tapez sur [ «~ = ] pour sélectionner <Add to Alarm> (Ajouter
a alarme), puis tapez sur [O].

*® Add to Alarm 3 Tapez sur [ % *] pour sélectionner <Yes> (Oui), puis tapez

sur[O].

= Le fichier musical sélectionné s'ajoute sur la liste des mélodies d'alarme.
Vous permet d'ajouter un seul fichier musical a la liste de mélodies d’alarme.




Affichage de I'image

Affichage de I'image

LT G TR Reportez-vous aux pages 20 et 21 pour le transfert des photos sur votre
= lecteur.

) 1 Appuyez longuement sur [ 2 ] et retenez-la
pour vous déplacer vers le menu principal.

2 Tapez sur [ % *] pour sélectionner <Music>
(Musique), puis tapez sur [(D)].
= Laliste de photos apparait.

[=1
8.
=
o0 [FiEinoo 3 Tapez sur [ < = < *] pour sélectionner le =
fichier photo souhaité, puis tapez sur [O)]. %
1 = Le fichier sélectionné apparait. =
= L'affichage des images de grande taille nécessite j?é}
J‘> ——- plus de temps.
1 E

i :__'_. [1,2] |Affichage du diaporama

]
: % 5 0 Vous pouvez visionner vos fichiers photo en
1==- 3 diaporama.

L= Tapez sur [(0)] en mode de visionnement de
photo.

= Le diaporama démarre.

« Les vignettes des photos |Z Tapez sur [] our mettre fin au diaporama.
s'affichent si l'information

&

afew,| ap abeyoiyy/enbisnw
ap uondo nuaw np uonesijin

REMARQUE " 3
appropriée est comprise . Lz .
dans le fichier. | Pour visionner la photo précédente/suivante
Les fichiers ne contenant
pas d'information affichent Tapez sur [ O].
plutot (] = La photo précédente ou suivante s'affiche a I'écran.
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Affichage de I'image

Utilisation du menu option de photo

| Pour écouter la musique en regardant vos photos

Vous pouvez écouter la derniere chanson lue tout en regardant votre photo.

1 Tapez sur [ 8 ] en regardant la photo.

= Le menu des options de photos apparait.

2 Tapez sur [ (0] pour sélectionner <Background Music On>
(Musique d’atmosphére activée) ou <Background Music Off>
(Musique d’atmosphere désactivée).

Add to Screen S « <Background Music On> (Musique d'atmospheére activée) : vous permet

d'écouter la derniére chanson lue tout en regardant votre photo.

= <Background Music Off> (Musique d'atmosphére désactivée) : aucune

musique d'atmosphere en regardant une photo.

| Pour ajouter une photo sur la liste des économiseurs d’écran

1 Sélectionnez un fichier photo que vous souhaitez ajouter sur la
] liste des économiseurs d’écran.

2 Tapez sur [ 8 ] en regardant la photo.
= Le menu des options de photos apparait.
B EU 3 Tapez sur [« =] pour sélectionner <Add to Screen Saver>

(Ajouter & écono. écran), puis tapez sur [ (O]
= Le fichier photo sélectionné est ajouté sur la liste.

= Sélectionnez <Photo> (Photo) depuis <Settings> (Réglages) — <Display> (Afficher) — <Screen Saver>
REMARQUE (Economiseur d'écran) et la photo sélectionnée s'affiche comme économiseur d'écran. » page 43

= Sivous réinitialisez le lecteur, 'économiseur d'écran sera remis a <Analog Clock> (Horloge
analogique).




Ecouter la radio FM

Ecouter la radio FM

Avan lenliiei > Branchez les écouteurs, puis allumez le lecteur et vérifiez la batterie.

(— 1 Appuyez longuement sur [ D ] et retenez-la
pour vous déplacer vers le menu principal.

2 Tapez sur [ % *] pour sélectionner <FM Radio>
(Radio FM), puis tapez sur [D].
= La réception de la radio FM est activée.

* FM Radio *=*

=
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=
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=3
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=
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=
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1 | Utilisation de la fonction Mute (Muet) =

=7}

. ] [S§)

Tapez sur [ ()] tout en écoutant la radio FM. M=

oo

= Le son est mis en sourdine. g =]

» Tapez sur [ ©)] une fois pour entendre le son de nouveau. I 2—

53
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= Branchez toujours vos écouteurs au lecteur lorsque vous recherchez ou réglez les fréquences. )

ATTENTION  Les écouteurs sont utilisés comme antennes de réception des ondes FM
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Ecouter la radio FM

Ecouter la radio FM (suite)

| Pour basculer vers le mode manuel
Sélectionnez ce mode si vous souhaitez effectuer une recherche manuelle d'une
fréquence a la fois sur la bande FM.

Preset Mode {m)

1 Tapez sur [ 8] en <Preset Mode> (Mode présélection).

2 Tapez sur [« = ] pour sélectionner <Go to Manual Mode>
(Aller au mode manuel), puis tapez sur [O)].
» <Manual Mode> (Mode manuel) s'affiche.

O
® Go to Manual M

| Pour basculer vers le Mode présélection

Sélectionnez ce mode si vous souhaitez effectuer une recherche de vos présélections
FM une a la fois.

MEREIede () 1 Tapez sur [ 8] en <Manual Mode> (Mode manuel).
2 Tapez sur [ «~ = ] pour sélectionner <Go to Preset Mode>

(Aller au Mode Présél.), puis tapez sur [(O].
= <Preset Mode> (Mode présélection) s'affiche.

91-1MHZ

» Go to Preset ..

3 Tapez sur [ % *] pour sélectionner la fréquence présélectionnée.

= Des que <Preset Mode> (Mode présélection) s'affiche, vous pouvez
sélectionner une fréquence radio et I'écouter.

» Siaucune fréquence n'est présélectionnée, le message <Preset list does not exist.> (Liste présélection
REVARQUE ingxistantg) s‘_afﬁche etle Iecte_ur ne'basculle pas en <Preset Mode> (Mode _présélection). )
= Sivous sélectionnez (Preset List) (Liste présélection) dans le menu des options FM, vous pouvez voir les
fréquences présélectionnées.
= Reportez-vous aux pages 36 et 37 pour plus de détails concernant la présélection.




| Pour rechercher automatiquement les fréquences

Appuyez longuement sur la touche [ % *] en <Manual Mode>
(Mode manuel).

= La fréquence la plus proche du point ou la touche est relachée est recherchée.

Tapez sur [ @] en <Manual Mode> (Mode manuel).

= Change de fréquence a chaque nouvelle pression du touche.

m
(2]
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c
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)
]
o
-
®
=
o
T
<
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Ecouter la radio FM

Réglage de la présélection FM

30 fréquences radio FM.

| Pour présélectionner automatiquement les fréquences

Go to Preset ..
Add Preset

FM Sensitivity

1 Tapez sur [ @] en mode FM Radio.

2 Tapez sur [ «~ = ] pour sélectionner <Auto Preset>
(Présélection auto.), puis tapez sur [()].
= La fenétre Auto Preset (Présélection auto) s'ouvre.

3 Tapez sur [ % *] pour sélectionner <Yes> (Oui), puis tapez
sur[O].
= Vous pouvez enregistrer automatiquement jusqu'a 30 présélections.

| Pour annuler une opération pendant le réglage

Tapez sur [ < *] pour annuler la balayage automatique.

= Le préréglage automatique est annulé et les fréquences réglées jusque-la sont enregistrées.

= Lutilisation de <Auto Preset> (Présélection auto) supprime toutes les présélections précédentes.

REMARQUE

Vous pouvez présélectionner jusqu’a



| Pour effectuer la présélection manuelle

Manual Mode {1l 1 Tapez sur [ < *] en <Manual Mode> (Mode manuel) pour
sélectionner la fréquence souhaitée.

91.1wHez 2 Tapez sur[ 8 ].

O (U D 3 Tapez sur [« » ] pour sélectionner <Add Preset> (Ajouter
présélection), puis tapez sur [(O)].

= La fréquence sélectionnée s'ajoute sur la liste présélection. Un maximum de
30 numéros présélectionnés s'ajoute sur la liste en classement séquentiel.

4 Pour définir un numéro présélectionné comme autre
fréquence, suivez les étapes 1 a 3 ci-dessus.

= Sivous tentez d'ajouter une fréquence déja existante sur la Liste présélections, <This preset already

REVARQUE exists.> (Cette présélection existe déja) s'affiche et elle n'est pas ajoutée.

| Pour rechercher les fréguences en mode Preset (Présélection)

o Ul Tapezsur [ 4 # ] en <Preset Mode> (Mode présélection).

= Le numéro préréglé est sélectionné ; vous pouvez alors écouter la fréquence
radio attribuée & ce numéro.

= Sivous souhaitez vérifier la Liste présélections en <Preset Mode> (Mode présélection), Tapez sur

REMARQUE [ ®] pour sélectionner <Preset List> (Liste présélections) et tapez sur [() ].

=
=
=
&
=
£
=3
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=
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Ecouter la radio FM

Pour supprimer les préeréglages

Delete Preset

» 89.1MHz

Tapez sur [ 8 ] en <Preset Mode> (Mode présélection).

Tapez sur [ «~ = ] pour sélectionner <Delete Preset>
(Supprimer Présél.), puis tapez sur [ (O]
= La fréquence présélectionnée s'affiche.

Tapez sur [« = ] pour sélectionner la fréquence
présélectionnée & supprimer, puis tapez sur [ ].
= La fenétre de confirmation apparait.

Tapez sur [ % *] pour sélectionner <Yes> (Oui), puis tapez
sur [O].

= Le numéro présélectionné sélectionné est supprimé.

Pour sélectionner et supprimer des numéros
présélectionnés, suivez les étapes 1 & 4 ci-dessus.



Ecouter la radio FM

Réglage de laradio FM

| Pour régler la réception FM

Manual Mode n

1 Tapez sur [ @] en mode FM Radio.

91wz

2 Tapez sur [ -~ =+ ] pour sélectionner <FM Sensitivity>
(Sensibilité FM), puis tapez sur [O].
® FM Sensitivity « Le menu FM Sensitivity (Sensibilité FM) apparait.

3 Tapez sur [ -~ =+ ] pour sélectionner la sensibilité, puis tapez
sur[O].

« Vous pouvez choisir entre <High> (Elevée), <Middle> (Moyenne) ou
<Low> (Basse).

= Plus la sensibilité est élevée, plus vous pouvez capter de fréquences.

olpelJ | ap abe|bay
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Réglages

Rég | ag e d ’ al ar m e Ce lecteur posséde une alarme qui peut se déclencher a I'heure

réglée.
AN ENEEEY En premier lieu, réglez Phorloge a Iheure actuelle. B page 43

1 Appuyez longuement sur [ *D ] et retenez-la pour vous
déplacer vers le menu principal.

2 Tapez sur [ % *] pour sélectionner <Alarm> (Alarme),
puis tapez sur [O)].

3 Tapez sur [ « =] pour sélectionner <New Alarm Set>
(Nouvelle Alarme), puis tapez sur [()].
= Le menu Alarm Settings (Réglages d’alarme) apparait.

4

Tapez sur [« =] pour sélectionner une fréquence, puis tapez
sur[ *].
= Sélectionnez entre <Once> (Une fois), <Off> (Désactivé), <Saturday~Sunday>

(Samedi~dimanche), <Monday~Saturday> (Lundi~samedi), <Monday~Friday>
(Lundi~vendredi), ou <Everyday> (A tous les jours).

Alarm Sound 2
Interval : 5 min

Tapez sur [ «~ = ] pour sélectionner <AM> (Avant midi) ou
<PM> (Apres midi), puis tapez sur [ *].

Tapez sur [ « =] pour régler I'heure, puis tapez sur [ *].
. = Vous pouvez
s configurer Tapez sur [ «~ = ] pour régler les minutes, puis tapez sur [ *].
QUE I
jusqu'a 6
L‘?gl':fni: Tapez sur [+ ] pour sélectionner un son d’alarme, puis

tapez sur [ *

I

Tapez sur [ -~ = | pour sélectionner un intervalle, puis tapez sur [(O)].
= La fenétre de confirmation apparait.

© ONO O

1 0 Tapez sur [ < * ] pour sélectionner <Yes> (Oui), puis tapez sur [()].
= Le réglage d'alarme est ajouté sur la liste d’alarme.



| Pour modifier le réglage d’alarme

AM 12 00
Alarm Sound 2

Interval : 5 min

1
2

3
4

Appuyez longuement sur [ " ] et retenez-la pour vous
déplacer vers le menu principal.

Tapez sur [ % *] pour sélectionner <Alarm> (Alarme),
puis tapez sur [(J].

Tapez sur [ «~ = ] pour choisir le réglage d’alarme a modifier
sur la liste, puis tapez sur [()].

Utilisez les touches [ = < ] et [(O] pour modifier le réglage.

| Pour supprimer le réglage d’alarme

1 Tapez sur [ -~ = ] pour choisir le réglage d’alarme a supprimer sur la liste, puis
tapez sur[ 8 ].
= La fenétre de suppression apparait.

2 Tapez sur [O].
= La fenétre de confirmation apparait.

3 Tapez sur [ « * ] pour sélectionner <Yes> (Oui), puis tapez sur [(].
« Le réglage d'alarme sélectionné est supprimé.

(Q « Le lecteur déclenche I'alarme a I'heure réglée. Alors, tapez sur [ . =+ ] et utilisez [ ()] pour sélectionner
REVERQUE <Alarm after 3 min> (Alarme aprés 3 min.) ou <Alarm Off> (Alarme désactivée).
Pour désactiver I'alarme, appuyez longuement sur la touche [ 2 ]. Vous reviendrez au menu principal.

n = La fonction d'alarme est désactivée lorsque le cable USB est branché au lecteur.

ATTENTION

(@)
=
[
=
=
=
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Réglages

CO nfl g u rat | on d e I ! éc [an Vous pouvez régler léconomiseur décran et

I'heure de mise hors tension de I'écran.

Settings
splay

Appuyez longuement sur [ 2] et retenez-la pour vous déplacer
vers le menu principal.

2 Tapez sur [ < *] pour sélectionner <Settings> (Réglages),
puis tapez sur [O)].
= Le menu Settings (Réglages) apparait.

3 Tapez sur [ «~ =] pour sélectionner <Display> (Afficheur),
puis tapez sur [O)].
= Le menu Time (Heure) apparait.

4 Utilisez les touches [« =] et [(D] pour régler les fonctions
souhaitées.

Fonctionnement de la touche
Tapez sur [ « = | pour défiler sur la liste.
REIRQUE " P [ = ] pour defi : )
» Tapez sur [ ©] pour sélectionner et confirmer vos réglages.

= Tapez sur [ o ] pour retourner a I'écran précédent.




« <Screen Saver> (Economiseur d’écran) : vous permet de sélectionner une image comme
économiseur d'écran. Sélectionnez entre <Analog Clock> (Heure analogique), <Animation1>
(Animation 1), <Animation2> (Animation 2) <Animation3> (Animation 3), and <Photo> (Photo)
puis réglez la période d'attente. <Photo> (Photo) s'agit d'une photo définie comme économiseur
d’écran dans <Add to Screen Saver> (Ajouter aux économiseurs d'écran). » page 32
Vous pouvez choisir entre <15 sec>, <30 sec>, <1 min>, <3 min>, <5 min>, et <Off> (Désactivé).
Si aucune touche n'est activée durant les périodes indiquées plus haut, le lecteur affiche
I'économiseur d'écran.

<Display Off> (Affichage désactivé) : si aucune touche n’est activée durant les périodes
indiquées plus bas, I'écran s'éteint automatiquement. Vous pouvez choisir entre <15 sec>,

<30 sec>, <1 min>, <3 min>, <5 min>, et <Always On> (Toujours activé). L'afficheur étant éteint,
appuyez sur toute touche pour le réactiver ainsi que les touches.

Réglage de I'économiseur d’'écran

1 Tapez sur [ -~ =] pour sélectionner <Screen Saver>
(Economiseur d'écran), puis tapez sur [(O)].

= Le menu des économiseurs d’'écran apparait.

2 Tapez sur [ -~

Q
>
I
=]
=
=
@
>
Py
D
=4
&
)
»

=] pour sélectionner I'image d’économiseur

15 sec
d’écran souhaitée, puis tapez sur [ *]. o
7 . 7o . °
3 Tapez sur [ «~ = ] pour sélectionner la période d’'attente, puis =
p «Q
tapez sur [(U)]. =
=
=« La fenétre de confirmation apparait. 2
) o
4 Tapez sur [ < *] pour sélectionner <Yes> (Oui), puis tapez sur [{)]. =
=%
= Les réglages de I'économiseur d’écran sont complétés. @
- D
Si vous réglez <Screen Saver> (Econo. écran) a <15sec> (15 sec), puis <Display Off> Q
(Affich. désactivé) a <15sec> (15 sec). %
REMARQUE
" L'économiseur d'écran sélectionné apparaitra dans 15 secondes si vous n'appuyez sur aucune touche.
Lorsque I'économiseur d'écran est ouvert, I'écran s'éteint dans 15 secondes si vous n'appuyez sur aucune
touche. 43




Réglages

Rég | ag e d e I 'h eure Non seulement pouvez-vous régler la date et I'heure, mais

aussi le minuteur de mise en veille et I'extinction auto.

St
o 1 Appuyez longuement sur [ 0 ] et retenez-la pour vous
déplacer vers le menu principal.

o Time

2 Tapez sur [ % *] pour sélectionner <Settings> (Réglages),
puis tapez sur [O)].
= Le menu Settings (Réglages) apparait.

3 Tapez sur [ «~ =] pour sélectionner <Time> (Heure), puis tapez
sur[O].

= Le menu Time (Heure) apparait.

4 Utilisez les touches [ « =] et [(D)] pour régler les fonctions
souhaitées.

» <Sleep Timer> (Minuteur de mise en veille) : permet d’éteindre automa-
tiquement I'appareil apres I'écoulement de la durée présélectionnée.
Sélectionnez entre <Off> (Désactivé), <15 min >, <30 min>, <60 min>,
<90 min>, ou <120 min>.

<Auto Power Off> (Heure d'arrét automatique) : permet d'éteindre
automatiquement I'appareil lorsque aucun touche n'est actionné avant
I'écoulement de la durée préréglée en mode Pause (Pause). Options
disponibles : <15 Sec> (15 s), <30 Sec> (30 s), <1 Min> (1 min),

<3 Min> (3 min), ou <5 Min> (5 min).

<Date/Time Set> (Réglage date/heure) : cette fonction vous permet de
régler la date et I'heure actuelles. » Page 45



Réglage date/heure

Date/Time Set

1 Tapez sur [ «~ =] pour sélectionner <Date/Time set>
(Date/Heure), puis tapez sur [(O].
= Le menu de format de date s'affiche.

2 Tapez sur [« = | pour régler I'heure, puis tapez sur [(O].

3 Tapez sur [ % *] pour vous déplacer sur <YY(year), MM(month),

DD(day), AM/PM, Hour, Minute> (YY (année), MM (mois), DD (jour),
Avant mide/Apres midi, Heure, Minute) et utilisez la touche [ + =]
pour régler la date et I'heure.

4 Tapez sur [O)].

= La fenétre de confirmation apparait.

5 Tapez sur [ % ] pour sélectionner <Yes> (Oui), puis tapez sur [O)].
= La date et I'heure sont enregistrées.
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Réglages

Rég | ag e d e Ia Ian g u e Vous pouvez définir la langue du menu.

Setti
] 1 Appuyez longuement sur [ " ] et retenez-la pour vous
déplacer vers le menu principal.

» Language

2 Tapez sur [ % *] pour sélectionner <Settings> (Réglages),
puis tapez sur [O)].

= Le menu Settings (Réglages) apparait.

Tapez sur [ «~ = ] pour sélectionner <Language> (Langue),
puis tapez sur [D].

Utilisez [ = =] et [ ] pour sélectionner la langue du menu.

» Options disponibles : <English>, < §=0{ >, <Francais>, <Deutsch>,
<ltaliano>, < BAZE >, < Bt X >, < KMPX >, <Espafiol>, < Pyccuii >,
<Magyar>, <Nederlands>, <Polski>, <Portugués>, et <Svenska>.

= Les langues prises en charge peuvent étre modifiées ou ajoutées.
REMARQUE
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Réglages

Rég Iag e d u Systém @ Vous pouvez régler plusieurs fonctions du lecteur.

1 Appuyez longuement sur [ "] et retenez-la pour vous

BEEY déplacer vers le menu principal.
Time
Language: 2 Tapez sur [ < *] pour sélectionner <Settings> (Réglages),

puis tapez sur [()].
» Le menu Settings (Réglages) apparait.

3 Tapez sur [ «~ = ] pour sélectionner <System> (Systéme),

puis tapez sur [(J].
= Le menu System (Systeme) apparait.

4 Utilisez les touches [ « =] et [(O)] pour régler les fonctions

souhaitées.

<Resume> (Reprise) : permet de définir le point de reprise de la lecture apres avoir terminé I'écoute de
la musique. Sélectionner <On> (Activé) reprend la lecture depuis le dernier point d'arrét tandis que <Off>
(Désactivé) reprend la lecture depuis le début de la derniere écoute de la musique.

<Beep> (Bip sonore) : Permet aux touches d'émettre un son lorsqu'ils sont activés. Options
disponibles : <On> (Activé) ou <Off> (Désactivé).

<Volume Limit> (Limite du volume sonore) : permet d'éviter les blessures aux oreilles en
réglant la limite du volume sonore lorsque vous utilisez les écouteurs. <On> (Activé) limite le
niveau du volume a 20 tandis que <Off> (Désactivé) le limite jusqu’a 30.

<FM Region> (Région FM) : permet de choisir votre région pour la radio FM. Sélectionnez
depuis <Other Countries> (Autres pays), <Korea/USA> (Corée/E.-U.) et <Japan> (Japon).
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f@ Bande de fréquences par région
- Autres pays : recherchez des fréquences FM comprises entre 87,50 MHz et 108.00 MHz pour les
! lecteurs de 50 kHz.
- Corée/Etats-Unis : recherchez des fréquences FM comprises entre 87,5 MHz et 108.0 MHz pour les
lecteurs de 100 kHz.
- Japon : recherchez des fréquences FM comprises entre 76,0 MHz et 108.0 MHz pour les lecteurs de 100 kHz.
La région FM peut étre supprimée ou modifiée en fonction de la région cible du lecteur.
Si vous modifiez la région FM, les fréquences radio préalablement enregistrées seront supprimées. 47
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Réglages

Réglage du systéme (suite)

= <Default Set> (Réglage par défaut) : permet de revenir aux valeurs de réglage par défaut.

= <About> (A propos de) : permet de vérifier la version de micrologiciel, la capacité de mémoire et le
numéro de piste.

. Firmware Version (Version de micrologiciel) : affiche la version de micrologiciel courante.

. Memory (Mémoire) : indique la capacité restante de la mémoire. <Used> (Utilisée) indique la partie
utilisée, <Remain> (Restante) indique la capacité restante et <Total> (Totale) indique la capacité de
mémoire totale.

. Files (Fichiers) : <Music> (Musique) indique le nombre de fichiers musicaux, <Photo> (Photo) le nombre
de photos et <Total> (Total) le nombre total de fichiers.

Réglage par défaut

acume 1 Tapez sur [« =] pour sélegtif)nner <Default Set> (Réglages

Beep par défaut), puis tapez sur [()].

Volume Limit » La fenétre de confirmation apparait.

FM Region

oo 2 Tapez sur [ < ] pour sélectionner <Yes> (Oui), puis tapez sur [()].
= <Yes> (Oui) : permet d'initialiser tous les réglages par défaut.

= <No> (Non) : permet d'annuler les réglages par défaut.

= Sivous réinitialisez le lecteur, toutes les fonctions réglées récuperent leur réglage a l'usine.

REMARQUE = A propos de la mémoire intégrée
La taille de la mémoire intégrée réelle disponible est Iégérement inférieure a celle indiquée, car le
micrologiciel interne en utilise une partie.
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Pour mettre a niveau le micrologiciel

Des mise a niveau peuvent étre disponibles pour ce lecteur afin d’en améliorer la
performance et la compatibilité.

1 Branchez-vous a htp://www.samsung.com, sélectionnez [SUPPORT] -
[DOWNLOAD CENTER] et ensuite, sélectionnez votre appareil.

2 Lorsque la page de I'appareil apparait, sélectionnez [Firmware] sous le nom du
modeéle pour télécharger le tout dernier micrologiciel.

Décompressez le fichier téléchargé sur votre bureau.
= Le fichier décompressé s'affiche.

4 Branchez le lecteur a votre PC a I'aide du cable USB.

Cliquez a droite sur la touche de
démarrage en bas a gauche de I'écran
de votre ordinateur, puis sélectionnez
Explorer pour ouvrir I'explorateur de
Windows sur votre ordinateur.

= [Samsung YP-K5] s'affiche dans I'explo-
rateur de Windows.

[212160j0101W 3]
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Pour mettre a niveau le micrologiciel (suite)

6 Trouvez et cliquez sur I'icéne Desktop
(Bureau) dans I'explorateur de Windows Qs - © - | Dt [ e |
(colonne de gauche). v fer )

Foiders x LMy Dacumenes.
Le contenu du bureau s’affiche dans la e ! It
: 5 1§ oy Computer o Ry b
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Trouvez et sélectionnez les fichiers de mise a
jour du micrologiciel (colonne de droite),
glissez et déplacez-les dans le fichier Data
(Données) de [Samsung YP-K5] - [Data].
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Le lecteur s’éteint automatiquement apres avoir débranché le cable USB.

Appuyez longuement sur I'interrupteur [ « HOLD] dans le sens opposée a la
fleche.

= Le micrologiciel est mis a jour.
= Le lecteur s'éteint automatiquement lorsque la mise a jour est complétée.

= Vérifiez 'état de chargement de la pile du lecteur. Si le chargement de la pile est insuffisant, le micro-

REMARQUE logiciel ne sera pas mis & niveau.




Dépannage

Si un dysfonctionnement survient, vérifiez les points suivants.
Si le probleme persiste, contactez le centre de dépannage Samsung le plus proche.

Probléme Points de contrdle et dépannage

L'appareil ne s'allume
pas.

Les touches ne
fonctionnent pas.

L'écran ne s'allume pas.

L'alimentation est
coupée.

Ladurée de vie de la
batterie différe de celle
indiquée dans le manuel.

Dysfonctionnement du
programme.

La connexion a
I'ordinateur est
désactivée.

L'appareil ne s'allume pas si la pile est entierement déchargée.
Rechargez la pile et remettez I'appareil sous tension.
Appuyez sur la touche Reset (Réinitialisation).

Vérifiez si l'interrupteur [HOLD] est dirigé dans le sens de la fleche.
Vérifiez si vous avez appuyé sur le bon touche, puis essayez de
nouveau. » Page 11

Appuyez sur la touche Reset (Réinitialisation).

Si vous sélectionnez <Display Off> (Affich. désactivé) depuis
<Settings> (Réglages) - <Display> (Afficheur), I'écran ACL
demeure éteint. Tapez sur n'importe quelle touche pour allumer
I'écran ACL ou vérifiez les réglages de I'afficheur. »page 43

Il se peut que les données affichées a I'écran ne soient pas
visibles sous les rayons directs du soleil.

Vérifiez I'état du bloc-piles.
L'alimentation se coupe automatiquement lorsque la pile est
entierement déchargée. rechargez la pile.

La durée du bloc-piles peut varier en fonction du mode sonore et
des réglages de I'écran.

La durée de vie du bloc-piles peut étre réduite si vous I'exposez a des
températures basses ou élevées pendant des périodes prolongées.

Vérifiez que la configuration requise de l'ordinateur a été
correctement établie.

Appuyez sur le menu Démarrer de la barre d'outil de votre ordinateur
pour lancer la mise & jour Windows. Sélectionnez les mises a jour et
le Service Pack. Ensuite, mettez-les a jour. Redémarrez votre
ordinateur et rebranchez I'appareil.
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Dépannage (suite)

Probléme Points de contrdle et dépannage

La lecture est
désactivée.

Le téléchargement du
fichier est désactivé.

Des fichiers ou des
données manquent.

Affichage anormal de la
durée de lecture.

L'appareil est chaud.
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= Vérifiez que le fichier disponible a bien été enregistré dans la mémoire.
= Assurez-vous que le fichier musical n’est pas endommageé.
= Vérifiez que la puissance de la pile est suffisante.

= Vérifiez que le cable USB est correctement branché.
Rebranchez-le au besoin.

= Assurez-vous qu'il reste de I'espace disponible sur la mémoire.

= Appuyez sur la touche Reset (Réinitialisation).

Vérifiez que le cable USB n'a pas été débranché durant le transfert du
fichier ou des données. Si tel est le cas, les fichiers/données mais
également I'appareil risquent d'étre endommagés. Vous devez faire
preuve d'une extréme prudence a cet égard car Samsung ne saurait
en aucun cas étre tenu responsable de la perte des données.

Vérifiez que le fichier est au format VBR (débit binaire variable).

Les phases de chargement peuvent générer de la chaleur. Cela
n'a aucune incidence sur la durée de vie de I'appareil ou sur son
fonctionnement.



A r b O res C en C e d eS m en u S Cette fonction vous permet de consulter

Ecran de sélection du menu

rapidement la structure du menu.

Music FM Radio Photo Alarm Settings
Display Time Language System
Screen saver Sleep Timer Resume
Display Off Auto Power Off Beep
Date/Time Set Volume Limit
FM Region
Default Set
About
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Caractéristiques du produit

Nom du modéle YP-K5
Alimentation 3,7V (Lithium polymere rechargeable)
Alimentation de la batterie intégrée 830 mAh

Fichier Compatibilité

Music : MPEG1/2/2.5 3 couches (8 kbps a 320 kbps, 22 kHz a 48
kHz), WMA(48kbps a 192kbps, 22kHz a 48kHz)

Image : JPEG (ISO/IEC 10918-1/Annexe F — Mode de
fonctionnement séquentiel DCT)

Sortie des écouteurs

20 mW(France 5 mW/CH)(16 Q)

Bande de fréquences de la sortie

20 Hz & 20 KHz

Taux de bruit

90 dB avec filtre passe bas 20 kHz (& partir de 1 KHz, 0 dB)

Durée de lecture

30 heures de musique (fondé sur MP3 & 128 kbps, niveau de volume
a 15 en mode normal)

Plage de températures de fonctionnement| -5 & 35°C
Etui Magnésium
Poids 3,74 0z (1069)

Dimensions (L x H x P)

1,87 X 3,86 X 0,7 inches (47,5 X 98 X 18,1 mm)

Fréquence FM

87,5~108,0MHz

Rapport signal FM 50dB
TH.D. FM 1%
Sensibilité FM utile 38dBp
Puissance de sortie | 0,7W/Ch x 2Ch
Enceinte Impédance 8Q
Bande de fréquences | 400 Hz a 20 KHz

e Le contenu de ce manuel est susceptible d'étre modifié en vue d’étre amélioré sans

notification préalable.



Caractéristiques du produit

L'unité qui se trouve avec ce manuel de I'utilisateur est fournie sous licence sous
certains droits de propriété intellectuelle de parties tierces. Cette licence est limitée a une
utilisation privée non commerciale par I'utilisateur final pour les contenus sous licence.
Aucun droit n’est concédé pour une utilisation commerciale.

Cette licence ne couvre aucun produit autre que celui-ci et ne peut étre étendue a un
produit ou processus qui n'est pas sous licence selon la norme ISO/IEC 11172-3 ou
ISO/IEC 13818-3 utilisé ou vendu avec ce produit.

La licence couvre uniquement l'utilisation de ce produit pour encoder et/ou décoder

des fichiers audio selon la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.

Aucun droit n’est cédé sous cette licence pour des caractéristiques ou des fonctions

du produit qui ne sont pas conformes & la norme ISO/IEC 11172-3 ou ISO/IEC 13818-3.
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Garant|e L|m|tee Samsung

Samsung Electronics Canada Inc. (SECA)
garantit ce produit contre tout défaut de fabrication.

SECA garantit aussi que si cet appareil ne fonctionne pas convenablement durant
la période de garantie et qu'il s'agit d'un défaut de fabrication SECA se réservera le
droit de réparer ou de remplacer I'appareil défectueux.

Toutes les réparations sous garantie doivent étre effectuées par un Centre de
service autorisé SECA. Le nom et 'adresse du Centre de service le plus prés de
chez vous peut étre obtenu en composant sans frais le 1-800-726-7864 ou en
visitant notre site web au www.samsung.ca

Main-d’oeuvre Pieces
un (1) an (au comptoir) un (1) an

Pour tous les modéles portatifs, le transport de I'appareil sera la responsabilité

du client. Le recu de vente original doit étre conservé par le client car cela constitue
sa seule preuve d'achat acceptée. Il doit le présenter au Centre de service agréé au
moment o il fait la demande d'une réparation sous garantie.

Exclusions

Cette garantie ne couvre pas les dommages causés par un accident, un incendie,
une inondation, un cas de force majeure, un mauvais usage ou une tension
incorrecte. La garantie ne couvre pas aussi une mauvaise installation, une
mauvaise réparation, une réparation non autorisée et tout usage commercial ou
dommages survenus durant le transport. Le fini extérieur et intérieur de méme
que les lampes ne sont pas couverts par cette garantie. Les ajustements par le
client qui sont expliqués dans le guide de I'utilisateur ne sont pas couverts en
vertu de cette garantie. Cette garantie sera automatiquement annulée pour tout
appareil qui aurait un numéro de série manquant ou modifié. Cette garantie est
valable seulement sur les apparells achetés et utilisés au Canada.
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Si vous avez des suggestions ou des questions concernant les produits Samsung,
veulillez contacter le Service Consommateurs Samsung.

Samsung Electronique Canada Inc., Service a la Clientéle

1-800-SAMSUNG (7267864)
Www.samsung.com/ca
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